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QUESTIONS? See Molecular Devices technical support: 
http://support.moleculardevices.com 
VERIFICATION
This slide loader is extensively tested and thoroughly calibrated before 
leaving the factory. Nevertheless, researchers should independently 
verify the basic accuracy of the slide loader using suitable test samples.
WARNING
If this equipment is used in a manner not specified by the 
manufacturer, the protection provided by the equipment may be 
impaired.
DISCLAIMER
This equipment is not intended to be used, and should not be used, in 
human experimentation or applied to humans in any way.
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Licensing Notice

Molecular Devices is not licensed under any patents owned by Oxford 
Gene Technology Limited (“OGT”), covering oligonucleotide arrays and 
methods of using them to analyze polynucleotides. The purchase of 
Molecular Devices products does not convey any license under any of 
OGT’s patent rights, including any right to make or use oligonucleotide 
arrays under OGT’s patents.
Customers may use Molecular Devices products to analyze 
oligonucleotide arrays according to OGT’s patented methods if those 
arrays have either been purchased from OGT’s licensed suppliers, or 
have been made by the customer under a license from OGT.
Please contact OGT to enquire about a license under OGT’s patents at 
licensing@ogt.co.uk.
USE OF THIS INSTRUMENT WITH MICROARRAYS MAY REQUIRE A 
LICENSE FROM ONE OR MORE THIRD PARTIES THAT HAVE PATENTS 
RELEVANT TO SUCH USE. MOLECULAR DEVICES DOES NOT SUGGEST 
OR PROMOTE THE USE OF THIS INSTRUMENT IN A MANNER THAT 
INFRINGES ON THE PATENT RIGHTS OF A THIRD PARTY. YOU ARE 
ENCOURAGED TO EVALUATE WHETHER A LICENSE IS REQUIRED FOR 
YOUR SPECIFIC APPLICATION OF THIS INSTRUMENT.  COMPANIES 
THAT HAVE INTELLECTUAL PROPERTY RIGHTS IN THE POTENTIAL 
FIELD OF APPLICATION OF THIS INSTRUMENT INCLUDE WITHOUT 
LIMITATION, AFFYMETRIX, INC. (“AFFYMETRIX”), AGILENT, AND 
OXFORD GENE TECHNOLOGY. THIS INSTRUMENT HAS NOT BEEN 
LICENSED OR APPROVED FOR DIAGNOSTIC APPLICATIONS.
THE USE OF THIS INSTRUMENT IN CONNECTION WITH MICROARRAYS 
MAY BE WITHIN THE SCOPE OF PATENTS HELD BY AFFYMETRIX. TO 
THE EXTENT THAT AFFYMETRIX PATENT RIGHTS ENCOMPASS THIS 
INSTRUMENT OR ITS USE, AFFYMETRIX HAS GRANTED A LIMITED 
PATENT LICENSE FOR RESEARCH USE ONLY AND NOT FOR USE IN 
DIAGNOSTIC PROCEDURES. SUCH LICENSE, IF APPLICABLE, IS 
LIMITED TO USE OF THIS INSTRUMENT WITH SPOTTED MICROARRAYS 
SEPARATELY LICENSED BY AFFYMETRIX. NO LICENSE IS CONVEYED, 
BY IMPLICATION, ESTOPPEL OR OTHERWISE, TO USE THIS 
INSTRUMENT WITH MICROARRAYS MADE USING IN SITU OR 
PHOTOLITHOGRAPHIC SYNTHESIS. NO OTHER LICENSE IS CONVEYED, 
BY IMPLICATION, ESTOPPEL OR OTHERWISE, UNDER ANY AFFYMETRIX 
PATENT OR OTHER INTELLECTUAL PROPERTY RIGHT.
This instrument is licensed by Affymetrix under the following patents: 
U.S. Patent Nos. 5,578,832; 5,631,734; 5,834,758; 5,936,324; 
5,981,956; 6,025,601; 6,141,096; 6,171,793; 6,185,030; 6,201,639; 
6,207,960; 6,218,803; 6,225,625; 6,252,236; 6,262,838; 6,335,824; 
6,403,320; 6,403,957, 6,407,858; 6,472,671; 6,490,533; 6,545,264; 
6,597,000; 6,643,015; and 6,650,411.
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Foreword
Who this manual is for
This manual is written for microarray service personnel and core lab 
personnel using the GenePix® SL50 Slide Loader. It contains the 
information required to load and operate the slide loader and perform 
routine maintenance procedures.

Conventions
Within the scope of this manual, the following typographical 
conventions are used:

CAUTION! Indicates an operation that may cause damage to the 
instrument, device, or data, if the precautions are not followed.

Related documentation
The customer documentation for the GenePix SL50 Slide Loader 
includes the GenePix® 4300A/4400A User Guide, the GenePix® Pro 7 
Software User Guide, and the GenePix® Pro online Help.

WARNING! Indicates an operation that may cause 
personal injury if precautions are not followed.

Tip! Provides useful information that helps apply the techniques 
and procedures in the text to your specific needs, and provides 
shortcuts, but is not essential to the completion of a procedure.

Note: Provides essential information for the completion of a 
procedure.
5001410 B 7 
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Introduction
The GenePix® SL50 Slide Loader is a robotic slide loader system that 
automates high-throughput operation of the GenePix 4300A and 4400A 
Microarray Scanners.
The software user interface for the GenePix SL50 Slide Loader is 
GenePix Pro 7.2 (and later) Software.

Features of the GenePix SL50 Slide Loader
The GenePix SL50 Slide Loader includes a wide range of features:

• Storage of up to 50 microarray slides
• A light-tight slide storage enclosure
• Removable slide cassettes
• Slide mapping
• Slide cassette detection
• Manual single-slide scanning capability, independent of the 

automated mechanism
• 3-axis robotic slide assembly, for moving slides from slide 

storage to the scanner and back
• Support for Auto PMT on all scan areas for individual slides
• Accommodation of standard 1 inch by 3 inch (25 mm by 75 mm) 

microscope slides
• Audible noise of less than 70 dB during operation
• Direct communication with the controlling PC using a USB 

connection
• Diagnostics for calibration and for field support of robotics
• Full compatibility with GenePix 4300A and 4400A Microarray 

Scanners
• Full integration with GenePix Pro 7.2 (and later) Software
5001410 B 9 
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Applications of the GenePix SL50 Slide Loader
The GenePix SL50 Slide Loader can be used for numerous applications 
related to the individual and batch processing of microarray slides, 
including, but not limited to:

• Gene expression arrays
• Protein arrays
• Arrayed comparative genomic hybridization (aCGH) arrays
• Chromatin immunoprecipitation (ChIP) arrays
• DNA methylation arrays
• SNP genotyping arrays
• RNA interference (RNAi) arrays
• MicroRNA (miRNA) arrays

Specifications of the GenePix SL50 Slide Loader 
and GenePix 4300A/4400A Microarray Scanner

Figure 1-1 GenePix SL50 Slide Loader and GenePix 4300A/4400A 
Microarray Scanner Specifications

Specification Measurement

Weight (GenePix SL50 Slide Loader) 41 kg

Weight (GenePix 4300A/4400A scanner) 45 kg

Combined Weight 86 kg

Combined Height 620 mm

Combined Width 807 mm

Combined Depth 870 mm

Mains Power Input 100V - 240 VAC, 125W

Mains Voltage Fluctuations Not to exceed 10% of nominal 
supply voltage

Equipment Class 1

Pollution Degree 2

Installation Category 2

Operating Environment Indoor Use Only

Altitude Not to exceed 2000 m

Operating Temperature 5 - 40 degrees C

Humidity < 80% RH at 40 degrees C
10 5001410 B 
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Safety and Regulatory Warnings and Markings
Note the warnings and markings below as part of the preventative 
maintenance of your slide loader.

WARNING! Biohazardous Material. It is your 
responsibility to decontaminate the slide loader, as well 
as any accessories, before requesting service from 
technical support or before returning the slide loader or 
any components to Molecular Devices.

WARNING! Biohazardous Material. Never perform any 
maintenance procedures on the slide loader in an 
environment where potentially damaging gases or 
liquids are present.

WARNING! Shock Hazard. Do not remove the protective 
enclosure or any covers marked with the high-voltage 
warning symbol.

WARNING! Shock Hazard. Always turn the power switch 
off and disconnect the main power cable before 
performing any maintenance procedures.

WARNING! Shock Hazard. The GenePix SL50 Slide 
Loader is an Equipment Class 1 product that relies on 
protective earth grounding for safe operation. To avoid 
potential injury, do not interrupt the protective earth 
ground conductor (inside or outside the instrument) or 
disconnect the protective earth ground terminal.
5001410 B 11 
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CAUTION! Do not touch or loosen any screws or parts other than those 
specifically described in the maintenance procedures. Doing so may 
cause misalignment and void the slide loader warranty.

CAUTION! Do not use the GenePix SL50 Slide Loader in a manner not 
specified by Molecular Devices. Doing so may impair the protection 
provided by the equipment and void the slide loader warranty.

WARNING! Pinching hazard. To avoid potential injury, 
use caution when working near a potential pinch hazard 
location.

WARNING! Lifting hazard. The slide loader weighs 
approximately 90 pounds (41 kg) and is precisely 
aligned to the scanner. To avoid potential injury and 
potential damage to the alignment and equipment, 
contact Molecular Devices if you need to move the slide 
loader.

This symbol indicates that you must not discard this electrical or electronic 
product in domestic household waste.

This symbol indicates the location of the Protective Earth Ground Terminal.
12 5001410 B 
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Electromagnetic Compatibility (EMC)

Regulatory Information for Canada 
(ICES/NMB-001:2006)
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

ISM Equipment Classification (Group 1, Class A)
This equipment is designated as scientific equipment for laboratory use 
that intentionally generates or uses conductively coupled radio-
frequency energy for internal functioning, and is suitable for use in all 
establishments, with the exception of domestic establishments and 
those establishments directly connected to a low-voltage power supply 
network which supplies buildings used for domestic purposes.

Information to the User (FCC Notice)
This equipment has been tested and found to comply with the limits for 
non-consumer ISM equipment, pursuant to part 18 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a non-residential installation. 
To maintain compliance with FCC regulations, shielded cables must be 
used with this equipment. Operation with non-approved equipment or 
unshielded cables can result in interference to radio and TV reception.
This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the 
instructions, can cause harmful interference to radio communications. 
There is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio 
or television reception (determined by turning the equipment off and 
on), the user is encouraged to try to correct the interference using one 
or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the physical separation between the equipment and 

the receiver.
• Connect the equipment and the receiver into outlets on different 

circuits.
• Consult the dealer or an experienced radio or television 

technician for assistance.
The user is cautioned that changes and modifications made to the 
equipment without the approval of Molecular Devices could void the 
authority of the user to operate this equipment.
5001410 B 13 
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Operation
The GenePix® SL50 Slide Loader should be in position on a flat level 
surface before operating. Before using, make sure that qualified 
Molecular Devices service personnel have installed and calibrated the 
GenePix SL50 Slide Loader.

Operation Startup Procedure
The GenePix SL50 Slide Loader is designed to work with a GenePix 
4300 Scanner or a GenePix 4400A Scanner. The startup procedure for 
using the slide loader and scanner involves the following procedures:

• Turning on the control computer on page 15
• Turning on the scanner on page 15
• Turning on the slide loader on page 16
• Starting the GenePix Pro Software on page 16

Turning on the control computer
Molecular Devices service personnel will install and set up the slide 
loader and scanner and connect them to a control computer where the 
GenePix Pro Software is installed. 

To turn on the control computer

• Turn on the control computer power switch.

Turning on the scanner
If this is the first time you are using the scanner, make sure you follow 
the procedures in the user guide for the scanner before you start the 
GenePix Pro Software.

To turn on the scanner

• Turn on the scanner power switch.
5001410 B 15 
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Turning on the slide loader
Initial startup of the GenePix SL50 Slide Loader includes a functional 
check to confirm that the slide loader is performing according to the 
specifications established by Molecular Devices. 

To turn on the slide loader

1. Open the slide enclosure door of the slide loader and install both 
the left and right slide cassettes. Go to To load the slide cassette 
on page 24.

2. Close the slide enclosure door.
3. Turn on the slide loader power switch.

The power LED turns on. No movement occurs.
4. If this is the first time you are turning on the slide loader or if 

you want to check the performance of the instrument, go to 
Performing a Functional Checkout on page 18.

Starting the GenePix Pro Software
While it is recommended that you perform a functional checkout after 
initial installation of the GenePix SL50 Slide Loader, this is not required 
each time you start the GenePix Pro Software.

GenePix Pro Software icons
The icons shown in Table 2-1 on page 17 are used when operating the 
GenePix SL50 Slide Loader.
16 5001410 B 
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Table 2-1 GenePix Pro Software icons

Icon Description

Scan Area Properties

Scanner Door is Open.
Click to Close Scanner Door.

Scanner Door is Closed.
Click to Open Scanner Door.

Hardware Settings

Preview Scan

Data Scan

Stop Scan
5001410 B 17 
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To start the GenePix Pro Software 

1. Make sure that the slide loader and scanner are both free from 
any obstructions.

2. On the control computer, click Start > Programs > Molecular 
Devices > GenePix Pro 7 > GenePix Pro 7.
The slide loader moves to its starting position. If the scanner 
door is open, the GenePix Pro Software closes the door before 
performing calibration. The scanner is calibrated and the 
GenePix Pro Software starts in Manual mode. 

CAUTION! It is important to use slides that are compatible with the 
GenePix SL50 Slide Loader microarray scanner. Using incompatible 
slides can result in damage to the scanner or to the slides. For more 
information, see Using Compatible Slides on page 31

CAUTION! It is important that you inspect the scanner’s slide holder, as 
prompted by the software, and remove any slides that might be 
remaining on the slide holder from a previous session. Failure to 
remove slides can damage the slide, scanner, or slide loader.

3. If you are changing from Manual mode to Batch Scan mode and 
the GenePix Pro Software prompts you to remove any slides in 
the slide loader, click OK.

Performing a Functional Checkout 
Use the Functional Checkout procedure to help you confirm that your 
GenePix SL50 Slide Loader is performing according to factory 
specifications. A similar, but much more detailed procedure, was 
performed at the factory prior to shipping your unit. 
The GenePix SL50 Slide Loader has been designed to provide robust 
service for years of normal use. However, if you think there is a 
problem with the slide loader, it is important to perform a functional 
check before contacting Technical Support.

Note: For optimum performance, allow the GenePix 
4300A/4400A Scanner to warm up for 15 minutes before 
scanning slides with the GenePix Pro Software.
18 5001410 B 
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We recommend that you perform a functional checkout once upon 
receiving the instrument and then at any time you want to check the 
performance of the instrument. The functional checkout procedure 
checks that:

• the slide detection mechanism on the GenePix SL50 Slide 
Loader is functioning correctly.

• the scanner and the slide loader are aligned correctly.
• the door of the scanner is opening and closing correctly and is 

synchronized with the slide loader.
• the Data Scan feature of the scanner is functioning correctly.

Follow the To perform a Functional Checkout procedure to load four 
compatible slides and configure and check the alignment and 
movement of the slide loader and scanner.

To perform a Functional Checkout

1. Follow the startup procedure for using the slide loader and 
scanner. See Operation Startup Procedure on page 15.

2. On the Batch Scan tab, in the Scan Type group, make sure 
that Batch is the selected scan type. 
If Manual is the selected scan type, click Select, select Batch, 
remove any slides on the scanner’s slide holder, and click OK.

3. On the slide loader, open the slide enclosure door and remove 
both the left and right slide cassettes.

4. Place four compatible slides in slide cassette positions 1, 25, 26, 
and 50. For more information, see Using Compatible Slides on 
page 31.

5. Return both the left and right slide cassettes into the slide 
enclosure.

6. Close the slide enclosure door completely.
The Map Slides button on the Batch Scan tab is enabled. The 
Scan Batch button remains disabled.

7. Click Map Slides.
The slide loader scans the two slide cassettes. When the scan is 
complete, the Map window is updated to show the available 
slides. The Scan Batch button is enabled.

8. On the Batch Scan tab, right-click on slides 1, 25, 26, and 50, 
and then select Data Scan Only for all four slides.

9. Click Save loader settings.

Tip! Slide cassette positions 1, 25, 26, and 50 are equivalent to 
positions 1 and 25 in each of the left and right slide cassettes.
5001410 B 19 
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10. On the Image tab, press Ctrl+N to create a New Settings file.
A scan area is created that matches the size of each slide. You 
can reduce the amount of time for the scan by reducing the scan 
area size.

11. Click Scan Area Properties.
12. Type the following values:

 Left: 3500
 Top: 5000
 Width: 15000
 Height: 3000

13. Click OK.
14. On the Batch Scan tab, click Scan Batch.

The batch scan begins and all four slides are loaded, scanned, 
and unloaded, based on the defined settings.
The GenePix Pro Software automatically logs hardware 
performance into the Hardware Diagnostics Report every two 
hours during operation.

Manual Scanning
In Manual scan mode, the GenePix Pro Software operates the scanner 
only, in a conventional way. You can open and close the motorized 
scanner door, perform Preview Scans, Data Scans, adjust scanner 
settings from the Hardware Settings dialog box, and stop and start 
scans. 
Any Global file options (Save locations, File name) set during a batch 
scan apply when performing a manual scan.
Follow the instructions carefully when inserting a slide in the scanner 
slide holder. The slide holder is a precision component designed to 
ensure proper focusing and field uniformity. Improper handling may 
damage the slide holder and affect imaging performance. In Manual 
scan mode, the GenePix SL50 Slide Loader is inactive and will not 
move.
20 5001410 B 
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To insert a slide in the scanner 

1. In the GenePix Pro Software, click the Open-Close Scanner 
Door icon to raise the scanner door.
The scanner slide holder moves forward into the load position.

CAUTION! Never touch the slide holder while it is moving. Never force 
the slide holder closed, or apply significant pressure to it.

2. With the slide held between your thumb and finger, carefully 
place the slide, feature-side down, into the slide holder.

.

Note: Make sure the barcode on the slide is facing the front of 
the slide scanner.

Figure 2-1 Scanner slide holder 

Ite
m Name Description

1 Scanner door In raised position

2 Slide holder In load position

2

3

1

4
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3. Click the Open-Close Scanner Door icon to close the scanner 
door.
The door closes and the slide holder moves into the scan 
position.

To scan a single slide

1. On the Batch Scan tab, in the Scan Type group, click Select.
The Scan Type dialog box appears.

2. Select Manual and click OK.
3. Insert a slide in the scanner. See To insert a slide in the scanner 

on page 21.
4. Click the Hardware Settings icon on the right-hand side of the 

GenePix Pro window.
5. In the Hardware Settings dialog box, set the filter and PMT 

parameters. 
6. Click the Preview Scan icon to scan the slide and display 

general data for the slide.
7. If you want to scan a smaller region, use the Scan Region tool 

to select a region, then click the Data Scan icon.
8. When you are finished scanning, click the Open-Close Scanner 

Door icon.
9. Remove the slide from the slide holder.

3 Slide Place feature-side down

4 Barcode Barcode is facing the front of the 
slide scanner

Figure 2-1 Scanner slide holder (cont’d)

Ite
m Name Description
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Batch Scanning 
In Batch Scan mode, the scanner scans all selected slides in the slide 
loader, without any user intervention. The GenePix SL50 Slide Loader 
contains a three-axis robot that moves slides from each cassette in the 
slide enclosure to the scanner and then returns slides to their original 
position, after scanning is complete. The robot and the slide enclosure 
are external to the scanner.
During the initialization procedure, when starting the GenePix Pro 
Software, the GenePix SL50 Slide Loader maps the slide positions in 
both slide cassettes. The motion arm senses the presence or absence of 
slide cassettes in the slide enclosure and will not start a scan if no slide 
cassettes are present. Only those positions containing slides are 
accessed during the scan.
On the Batch Scan tab, you can customize various settings.

• For each slide in the slide carrier, you can specify hardware 
(scanner) settings and analysis settings. 

• For the entire batch scan, you can specify file naming and 
saving options, as well as workflow options. Note that any 
Global file options set during a batch scan apply when 
performing a manual scan.

While scanning, the positions in the GenePix Pro slide carrier map 
change color depending on their scan status: 

• Light-blue outline: Scan is in progress. 
• Green: Scan was completed successfully. 
• Red: Slide was not scanned because of a slide handling failure or 

scan cancellation.
5001410 B 23 
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To load the slide cassette

1. Use the handle on the right side of the slide loader tower to slide 
open the slide enclosure door.

Figure 2-2 Slide enclosure door handle
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2. Using the handle on top of the slide cassette, lift the left slide 
cassette out and place it on a stable position on the counter.

Figure 2-3 Slide enclosure door open with both slide cassettes 
visible

3. With each slide held between your thumb and finger, carefully 
place slides, feature-side down and barcode facing the front, 
into empty slots in the slide cassette.

4. When you have placed all slides for scanning into the slide 
cassette, return the cassette to the slide enclosure by inserting 
it at a slight angle tilted away from you, then straighten it until it 
fits securely in the slide enclosure. You will hear a click when it 
is in place.

5. If additional slots are required, perform Step 2 through Step 4 
with the right slide cassette.

CAUTION! Do not access the slides in the cassette through the belt 
opening.

Note: The motion arm uses a sensor to locate and map slides in 
the cassette slots before beginning the batch scan.
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6. When all slides are loaded into the slide cassettes and the 
cassettes are returned to the slide enclosure, use the handle on 
the slide loader tower to slide both cassettes back into the slide 
enclosure. Both slide cassettes must be in the slide enclosure for 
the GenePix Pro Software to recognize that the slide enclosure is 
completely shut.
You will hear a click when the slide enclosure is completely shut.

To perform a batch scan

1. On the Batch Scan tab, in the Scan Type group, make sure 
that Batch is the selected scan type. 
If Manual is the selected scan type, click Select, select Batch, 
remove any slides on the scanner’s slide holder, and click OK.

Slide positions containing slides to be scanned are indicated in 
light blue on the slide cassette map.
Slide positions containing no slides are indicated in white.
Slide positions in gray indicate that a slide is present but has not 
been selected to be scanned (based on the current GenePix 
SL50 Slide Loader settings).
By default, all slides present in a batch are scanned.

2. Click the Hardware Settings icon on the right-hand side of the 
GenePix Pro window.

3. In the Hardware Settings dialog box, select the laser and filter 
settings for all slides. To override these hardware settings for 
individual slides, ensure that you select specific hardware 
settings for selected sub-batches of slides in Step 8.

4. In the global file options group, click Save Locations [...] to 
open the Options > Folders dialog box and set the directories 
in which to save various file types.

5. In the global file options group, click File name [...] to open 
the Options > File Save dialog box and set the naming 
conventions for files saved during batch scans.

Note: For optimum performance, allow the GenePix 
4300A/4400A Scanner to warm up for 15 minutes before 
scanning slides with the GenePix Pro Software.
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6. If you want to save all settings on the Batch Scan tab to re-use 
in another scan or if you want to open a previously saved 
settings file, use the Loader Settings group and select one of 
the following options:
 Click New to save the batch scan configuration in a loader 

settings file (*.gpa).
 Click Open to open a previously saved loader settings file 

(*.gpa).
7. If you want to scan a slide multiple times (for example, at 

different PMT settings or using different scan regions), do the 
following:
 Select the slide in the Batch Scan list.
 Use the arrows in the Scan # times field to set the number 

of times to scan the slide.
Based on the number of times selected, the scan is copied in the 
Batch Scan list (for example 1a, 1b) and each instance of a scan 
gets its own entry. You can assign scan settings to each entry 
independently.

8. If you want to select a sub-batch of slides for scanning, use Ctrl-
click and Shift-click to select multiple slides in the Batch Scan 
table, and then select the following settings for the sub-batch 
scan in the For the selected sub-batch of slides group.
 Click the Scans drop-down list to select the type of scan to 

perform on the selected sub-batch of slides.
 Type a File name body to save the selected sub-batch of 

slides with a specific file name.
 Choose the Hardware Settings for the selected sub-batch 

of slides either by clicking Current settings or by clicking 
GPS file and using the [...] button to navigate to a specific 
GenePix Settings (GPS) file.

 For each slide in the selected sub-batch, choose the Auto 
PMT gain either by clicking Selected hardware settings to 
use the current hardware settings or by clicking GAL file 
and using the [...] button to override the specified settings 
and navigate to a specific GenePix Array List (GAL) settings 
file.

Note: For information on Auto PMT, see Setting PMT Gain 
Automatically on page 29.
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9. If you have multiple sub-batches, repeat Step 8 for any other 
sub-batches selected.
To copy and paste slide settings from one slide to another, select 
a row and use the Copy Row and Paste Row buttons at the 
bottom of the Batch Scan tab. 

10. In the After batch scan group, select what you want to happen 
when the batch scan is complete:
 If you want to browse the scanned images without analyzing 

them, use the Browse tool on the Batch Analysis tab.
 If you want to run a batch analysis after the batch scan is 

complete, check Add image files and analysis settings 
files to Batch Analysis tab and type a name for the file, 
and then click Run batch analysis.

11. If you want to save the current configuration of the Batch Scan 
tab settings with a new file name, click Save loader settings 
[...] and enter a new file name.

12. Click Scan Batch to perform a batch scan using the settings 
configured on the Batch Scan tab.

When the batch scan is complete, a message appears in the 
GenePix Pro Software. 

Stopping a Batch Scan
You can stop a batch scan at any time during the scan. You can then 
choose to continue the scan or to cancel it.

To stop the current scan

1. In the GenePix Pro Software, click the Stop Scan icon.
2. Choose one of the following options:

 To continue scanning the batch from the current position in 
the slide carrier, click Continue. 

 To cancel the batch or to restart a batch from a position that 
has already been scanned, click Stop.

Note: Do not disturb the scanner or slide loader during the 
batch scan. Depending on the resolution and the number of 
wavelengths or channels you select for scanning, a single scan 
can take from 4 to 35 minutes to complete.
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Setting PMT Gain Automatically 
GenePix Pro Software and the GenePix SL50 Slide Loader support 
automatic setting of PMT gain (Auto PMT) when scanning. The 
algorithm requires a GenePix Array List (GAL) or GenePix Settings 
(GPS) file that both accurately describe the size of features, and their 
approximate positions. The GAL/GPS file does not need to be aligned to 
features, but it does need to be roughly near the features on the array. 
For more information on PMT topics, see the GenePix Pro online help.

Performing a Batch Analysis 
After a Batch Scan is completed, you can automatically analyze all the 
images by adding them to the Batch Analysis tab. 

To perform a batch analysis 

• On the Batch Analysis tab, either click Select GAL or Select 
GPS to select a GenePix Array List (GAL) or GenePix Settings 
(GPS) file for analysis.
For more information on batch analysis, see the GenePix Pro 
online help. Locate the Batch Analysis topic in the GenePix Pro 
Features section.

Reviewing the Batch Scan Log File 
The GenePix Pro Software saves a log file for each batch of slides that it 
scans. If there is a problem with a batch, you should open and review 
the log file for diagnostic information.
The log file is saved by default in the …\Documents\Molecular 
Devices\GenePix Pro\Data directory, but you can specify where it is 
saved.

To open a batch scan log file

• From the main menu, select File > Open Batch Scan Log.

To select a location for the batch scan log file

1. On the Batch Analysis tab, select Use folder options.
2. In the Options dialog box, click the Folders tab.
3. On the Folders tab, click Specified folder for individual file 

types.
4. In the Slide Loader Log field, click Browse to navigate to a 

location to store the batch scan log file.
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Shutting Down the Slide Loader
Proper shutdown of the GenePix SL50 Slide Loader ensures that the 
slide loader and software are not damaged.

To shut down the slide loader

1. Close the GenePix Pro Software.
2. Turn off the slide loader power switch.
3. Turn off the scanner power switch.
4. Turn off the control computer.
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Routine Maintenance and 
Troubleshooting
The GenePix® SL50 Slide Loader requires very little maintenance. 
Routine maintenance procedures are limited to installing additional 
filters.
The user can perform basic troubleshooting procedures for the slide 
loader. However, if the slide loader is damaged or requires repair, 
contact Molecular Devices.

Using Compatible Slides

CAUTION! Use only slides that are compatible with the GenePix SL50 
Slide Loader microarray scanner. Damage to the scanner caused by 
incompatible slides is not covered by warranty or service contract. 
Contact Molecular Devices if you are not sure if your slides are 
compatible.

The slide cassette can accommodate slides that are between 0.9 mm 
and 1.1 mm thick, including any labels. Slides thicker than 1.1 mm will 
not fit properly in the slide carrier and can cause slide-handling failure 
because of the manual force required to remove the slides from the 
cassette. Make sure that slides move freely in the slide cassette when 
you insert them. Slides thinner than 0.9 mm will not remain in the 
proper position in the slide cassette for pick-up by the motion arm.

Slide edges should be either square-cut or rounded.
Make sure you keep a 2mm-wide area on the long edge of each slide 
free of any material (for example, coverslips).

Figure 3-1 Slide dimension requirements

Slide Dimension Minimum Maximum

Length 74.50 mm 76.35 mm

Width 24.90 mm 25.90 mm

Thickness
(including labels)

00.90 mm 01.10 mm
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Make sure that slides are free of sticky substances that might adhere to 
the motion arm. Sticky substances can result from use of labels, 
adhesives, attached superstructures, waxy coatings, or polish. These 
substances can cause slide-handling failure during the loading and 
unloading of the slide in the slide cassette.
Position arrays at least 7 mm from the front end of each slide to avoid 
contact with the motion arm during slide handling.

Figure 3-2 Slide compatibility details

Removing Particles from Equipment
Periodically check both the scanner and the slide cassettes for glass 
slide particles that can accumulate over time. Use only a brush or 
vacuum to remove particles. Do not use an aerosol duster to remove 
particles because this can distribute particulates to other areas of the 
scanner and this can result in airborne particles that can cause eye and 
nose irritation.

Troubleshooting Fuse Errors
If the GenePix SL50 Slide Loader does not start up, a fuse may no 
longer be functioning. If you suspect a fuse has stopped functioning, 
contact Technical Support.
Replaceable fuse specifications: 6.3 mm x 35 mm, 2 Ampere, 250 V, 
time delay.
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Returning the Slide Loader to Home Position
If the GenePix SL50 Slide Loader is operating, but not operating 
reliably, you might need to stop and restart the GenePix Pro Software 
to return the slide loader to its Home position.

CAUTION! If a slide remains in the motion arm, shut down the system 
and remove the slide before attempting to initialize the slide loader. A 
slide in the gripper can be damaged when the slide loader moves to its 
lowest point during the procedure.

To return the slide loader to Home position

1. Close the GenePix Pro Software.
2. Start the GenePix Pro Software.
3. If a slide remains in the motion arm, when the slide loader has 

moved to its far right position, turn off the slide loader power 
switch, and then carefully remove the slide from the gripper. 
After removing the slide from the gripper, turn on the slide 
loader power switch.

4. Close the GenePix Pro Software.
5. Start the GenePix Pro Software.

The slide loader returns to Home position. The GenePix Pro 
Software starts in Manual mode.

6. Perform manual scans as required. For more information, see 
Manual Scanning on page 20.
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Warranty and Service
Molecular Devices is committed to ensuring the highest quality of our 
products and customer service.
If you have any problems with your GenePix® SL50 Slide Loader, 
contact Technical Support group. In the US, contact us at 1-800-635-
5577. For locations outside the US, please contact your local Molecular 
Devices sales representative. 

Standard Warranty 
Molecular Devices warrants its non-consumable hardware products to 
be free from defects in materials and workmanship for 12 months from 
date of invoice or date of purchased installation visit, whichever is later. 
The warranty covers the cost of parts and labor to repair the product. 
Please keep the shipping container for future use. If you require an 
additional container, one can be provided for an additional charge. 
Products returned for repair should be properly packaged with 
transportation charges prepaid. Molecular Devices will pay for the 
return shipping of the product to the customer. If the shipment is to a 
location outside the United States, the customer is responsible for all 
duties, taxes and freight clearance charges.
The warranty is valid when the product is used for its intended purpose 
and does not cover products which have been modified without 
approval from Molecular Devices, or which have been damaged by 
abuse, accident or connection to incompatible equipment.
This warranty is in lieu of all other warranties, expressed or implied.

Out-of-Warranty Repair Service
Out-of-warranty repair service is available. Contact Technical Support 
for more information.

Optional Service Agreement
Purchasing an optional Service Agreement extends the coverage of the 
Standard Warranty. Contact Molecular Devices for current rates.
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Technical Support
In order to receive the best possible technical support, we encourage 
you to register on our web site www.moleculardevices.com/login.php, 
especially if your sales transaction was conducted by a purchasing 
agent. Your name in our database ensures that we can contact you 
directly with important information about product upgrades and special 
promotional opportunities. Once you register your name, you can then 
register your instrument.
If you require advice on the use of your GenePix SL50 Slide Loader, do 
not hesitate to contact Technical Support. Visit our Technical Support 
web site at http://support.moleculardevices.com and complete the 
Technical Support Request form. 
You can also phone Technical Support at:
1-408-747-1700 or
1-800-635-5577 (USA only) or
+44 118 944 8000 (EU)
Follow the prompts for GenePix Technical Support. 
Staying in touch with all of our customers is a valuable part of our 
ongoing development process, ensuring the excellence of every product 
we offer.
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